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Integrated Development Environment e² studio 
How to use Doxygen in e² studio 
Introduction 
Doxygen is a tool that generates documentation based on the Doxygen comments written in your program. 

To easily use the documentation generation tool Doxygen on e2 studio, use the Eclox plugin. 

This document describes the basic operation procedures for generating documentation with Doxygen using 
the Eclox plugin. 
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1. Overview 
1.1 e2 studio and Doxygen 
e2 studio is an integrated development environment for Renesas microcontrollers based on the open source 
"Eclipse". By embedding various plugins of Eclipse, e2 studio is possible to realize work with external tool 
and add/extend features. 

Doxygen is a tool that generates documentation based on Doxygen comments written in your program. It 
generates documentation using source code and a Doxygen configuration file as input. 

Eclox is a plugin that makes it easy to use the documentation generation tool Doxygen on Eclipse. The Eclox 
plugin provides the following functions: 

 Generating and configuring Doxygen configuration files 

 Controlling the execution of Doxygen commands 

This document describes the standard operation procedures of installing the Eclox plugin and generating 
documentation with Doxygen using the Eclox plugin on e2 studio. 

 

Note: For information on the format of Doxygen comments, refer to the Doxygen manual 
(https://doxygen.nl/manual). 

 

1.2 Workflow 
The following shows the workflow for generating documentation by Doxygen using the Eclox plugin in e2 
studio. This document explains how to operate the procedures outlined in bold blue frames according to this 
workflow. 

 

 
Figure 1 

 

 

https://doxygen.nl/manual
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1.3 Environment 
Renesas has confirmed the operating procedure explained in this document in the environment below. 

Renesas does not warrant the general behavior of that tools' usage with e2 studio as these are open-source 
software managed by third parties. We appreciate your understanding regarding any issues that may arise 
from their use. 

[OS] 

 OS:   Windows 10 (64 bits) 

[Tool] 

 e2 studio  2024-04 

 Doxygen*1 *3  1.8.16 (Bundled with the Eclox plugin) 

 Eclox*3  0.13.0 

 Graphviz*2 *3  11.0.0 

[Project] 

 This document does not describe how to create a project. Please prepare the project yourself. 

This document uses a project for the RA family as an example. 

 Project name:  sample 

 Board:   EK-RA6M4 

 Toolchain:  GCC ARM Embedded 

 Project type:  Flat 

 FreeRTOS:  FreeRTOS - Blinkey 

 

*1: The latest version of Doxygen at the time of writing this document is 1.11.0. 

*2: Doxygen uses an external program called Graphviz to generate diagrams such as class diagrams. If you 
use Doxygen, it is recommended that you install Graphviz. 

*3: Doxygen, Eclox, and Graphiv are not Renesas products and therefore those software are not covered by 
technical support. For specific usage, please refer to "4. Reference Information" and read the manuals for 
each software. 

 

The open-source software is governed by its own license. Please check the license for each software and 
use it in accordance with the license. 
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2. Setup 
This chapter describes the procedure to install the Eclox plugin to e2 studio and enable Doxygen on e2 studio 
so that you can easily generate documentation using Doxygen on e2 studio. 

Before you begin installing the Eclox plugin, you should have the following ready: 

 e2 studio is installed correctly 

 Doxygen is installed correctly 

(If you are using the version of Doxygen bundled with the Eclox plugin, you do not need to have 
Doxygen installed at this point.) 

 Graphviz is installed correctly 

 

2.1 Install Eclox plugin 
The Eclox plugin can be easily installed from the Eclipse Marketplace. 

To install the Eclox plugin to e2 studio: 

1) Launch e2 studio and select the menu item [Help] > [Eclipse Marketplace...]. 

2) The [Eclipse Marketplace] window appears. On the [Find:] field, enter "Doxygen", and press the [Go] 
button. 

3) The search result will show "eclox 0.13.0". Press the [Install] button. 

 
Figure 2 

4) The [Confirm Selected Features] page appears on the same window. Press the [Confirm >] button. 

5) The [Review Licenses] page appears on the same window. Select the "I accept the terms of the license 
agreements" and Press the [Finish] button. 

6) Start installing the Eclox plugin to e2 studio. During the installation process, the [Trust Authorities] dialog 
appears. Press the [Select All] button, then press the [Trust Selected] button. 

7) Next, the [Trust Artifacts] dialog appears. Press the [Select All] button, then press the [Trust Selected] 
button. 

8) Finally, the [Software Updates] message appears. Press the [Restart Now] button. 
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After restarting e2 studio, the installation process is complete. 

 

2.2 Select Doxygen version 
To select Doxygen version: 

1) Select the menu item [Window] > [Preferences] on e2 studio. 

2) The [Preferences] dialog appears. Move to the [Doxygen] panel after selecting the tree item [Doxygen]. 

3) Check Doxygen version number which you want to use. 

For the purposes of this document, check the "1.8.16" checkbox bundled with the Eclox plugin. 

 
Figure 3 

4) Press the [Apply and Close] button. 

 

  



Integrated Development Environment e² studio How to use Doxygen in e² studio 

R20AN0266EJ0101  Rev.1.01  Page 6 of 13 
Jul.10.24  

3. Documentation generation 
To use Doxygen, you need to generate a Doxygen configuration file (file extension: .doxyfile) in your project 
for which you want to generate documentation, and write the settings for the format of the output 
documentation. By using the Eclox plugin, you can easily generate a Doxygen configuration file in e2 studio 
and configure that file in the GUI. 

This chapter describes the procedure for generating and configuring a Doxygen configuration file in e2 studio 
to generate documentation. 

 

3.1 Generate Doxygen configuration file 
To generate a new Doxygen configuration file: 

1) Select a target project in the [Project Explorer] view on e2 studio. 

2) Next, select the menu item [File] > [New] > [Other...]. 

3) The [Select a wizard] dialog appears. Select the tree item [Other] > [Doxyfile] in the [Wizard:] treebox 
and press [Next >] button. 

 
Figure 4 

4) The [Doxygen Configuration] page in the [New Doxygen Configuration] dialog appears. The "Enter or 
select parent folder:" editbox and treebox are filled in for the selected project name. And, the "<project 
name>.doxyfile" is specified with the [Doxyfile name:] editbox as the default. Check them and edit them 
if necessary. 

 
Figure 5 
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5) Next press the [Finish] button. Then, a Doxygen configuration file is generated in your project. 

 
Figure 6 

 

3.2 Configure Doxygen configuration file 
When double-clicking the Doxygen configuration file in the [Project Explorer] view, the Doxygen configuration 
file editor appears. The editor has the [Basic] tab and the [Advanced] tab. You can configure your Doxygen 
configuration file in the editor. 

 

3.2.1 [Basic] tab 
The [Basic] tab allows you to configure basic settings for the generated documentation. Follow the 
explanation below to configure the settings on the [Basic] tab. 

 
Figure 7 
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 [Project] area 

 [Name:] editbox 

Enter your project name. Documentation will be generated with this name as its title. 

For the purposes of this document, enter "sample" into this editbox. 

 [Version or identifier:] editbox 

Enter a version number of documentation. 

For the purposes of this document, enter "v1.00.00" into this editbox. 

 [Input directories] listbox 

Add folders of source files you want to document. 

For the purposes of this document, add "ra", "ra_cfg", "ra_gen", "script" and "src" to this listbox. 
And check the [Scan recursively] checkbox. 

 [Output directory] editbox 

Enter the output folder for documentation. You can specify the folder with pressing the 
[Browser...] button. 

When you select the "HTML" as the document format in the [Output Formats] area, the 
document will be generated in the html folder automatically. Hence, for the purposes of this 
document, leave this editbox blank. 

 [Mode] area 

Select the desired extraction mode and program language. 

For the purposes of this document, select the "documented entities only" and the "C". 

 [Output Formats] area 

Select the document format you want to generate. 

For the purposes of this document, select only "HTML". 

 [Diagrams to Generate] are 

Select what you want to output to the document. 

Graphviz is the open-source software, cross-platform graph drawing tool. Doxygen can output 
advanced diagrams and graphs using the dot tool for Graphviz. If you want to output diagrams, 
check the "Use dot tool from the Graphviz package to generate" checkbox. 

For the purposes of this document, select the "Use dot tool from the Graphviz package to generate" 
and check all of its associated checkboxes. 

 

3.2.2 [Advanced] tab 
The [Advanced] tab allows you to configure detailed settings for the generated documentation. Some setting 
items on this tab overlap with the settings on the [Basic] tab. For items that cannot be configured on the 
[Basic] tab, configure the settings on the [Advanced] tab according to the following explanation. 

Pressing the [Custom] button and entering the item name in the editbox will filter the [Settings] listbox, 
making it easier to find the item you want to configure. 
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 [Output Language] 

Enter the language name (default: "English") for the generated documentation. 

 
Figure 8 

 [Input Encoding] 

Enter the encoding (default: "UTF-8") for the source files. 

 
Figure 9 

 [Extract All] 

For the purposes of this document, select "Yes, as this is the appropriate setting for generating C 
documentation (default: "No"). 

 
Figure 10 
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 [Generate Tree View] 

For the purposes of this document, select "Yes" as this is the appropriate setting for HTML 
generation (default: "No"). 

 
Figure 11 

 [Dot Path] 

Enter the path to the Graphviz (default: blank). If the path contains space character, enclose it in 
double quotation marks "". 

 
Figure 12 

 

3.3 Build documentation 
When you select your Doxygen configuration file in the [Project Explorer] view and select the menu item 
[Build Documentation] from the context menu, Doxygen will run, and documentation will be generated based 
on the Doxygen comments in the source files. 

 

 
Figure 13 
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You can double-click the generated index.html in the [Project Explorer] view to launch a browser and display 
index.html. 

 
Figure 14 
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4. Reference Information 
4.1 Web Site 

 Doxygen home page URL: 

https://www.doxygen.nl/ 

 Eclox home page URL: 

https://anb0s.github.io/eclox/ 

 Graphviz home page URL: 

http://www.graphviz.org/ 
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Revision History 

Rev. Date 
Description 
Page Summary 

Rev.1.00 Oct.01.12 All Created new. 
Rev.1.01 Jul.10.24 All Review all pages and updated all according to the latest 

version description. 
 

 



 

 

General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020)  

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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